BASIC EDITING

A Guide to Web Page Management for
Winona State University

WSU Teaching, Learning & Technology Services
## Contents

System Requirements .................................................................................................................. 3
Logging into Open Text .............................................................................................................. 4
Project Selection ....................................................................................................................... 4
   RedDot Administration Home .................................................................................................. 4
Spotting the Dot ........................................................................................................................ 5
Page ID, Headline and Filename ................................................................................................. 6
Search to Locate the Web Content to Edit .................................................................................. 7
Editing Web Pages in Open Text ............................................................................................... 9
Quick Links Area ....................................................................................................................... 11
Using the Text Editor Window to Edit Content – Ephox Editor ............................................... 13
Edit Photo Selections ................................................................................................................ 14
Uploading Images and Files  **This process is for adding photos inside the content area only.** .......................................................... 16
   Fill in a short description of the photo. Used for search engine optimization. Can use the same name for each. This menu will show up when inserting photos with the [Edit Photo] dot. ................................................ 17
   Again fill in a short description on Alt Text field .................................................................... 17
   Use the Images folder ........................................................................................................... 18
Uploading and Linking to PDF Files – Prepare before uploading ............................................. 19
Creating Links in Open Text ...................................................................................................... 20
   Linking to a URL – (Internet Tab) ........................................................................................ 20
   Linking to an existing WSU Open Text Page – (Page Tab) ..................................................... 20
   Linking to an Email Address – (Email Address Tab) ............................................................. 20
   Linking to a File – (File Tab) .............................................................................................. 21
   Linking to Book Mark – (Jump Mark Tab) .......................................................................... 21
Creating a Table ........................................................................................................................ 22
Releasing and Publishing Your Web Page .................................................................................. 24
Content Management Systems
Web Content management is a software tool that allows for:
- Easy creation and modification of online content by non-web experts;
- Automated maintenance tools for the Webmaster;
- Easy organization and retrieval of content using appropriate menus and search technology.

The advantages to content management systems include the:
- Ability for end users to enter and update information on the web without having any knowledge of HTML coders;
- Ability to enforce a standardized appearance that remains consistent from one department to another;
- Ability to provide end users with individual access rights and limit the information that may be modified.

Open Text is Winona State University’s Content Management System.

System Requirements

Computer
Open Text can be used on a Windows-based PC or Macintosh computer.

Internet Browser
Internet Explorer is the preferred browser.
For Macs: Firefox is most consistent, Safari does not work
Logging into Open Text

Launch Internet Explorer

Set your URL to: [https://cms.winona.edu](https://cms.winona.edu)

*Note: If you are off campus, you will need to run VPN first. Then launch IE and enter the URL.*

Enter your WSU user name
Enter your WSU password

*(same as your network/email account)*

Click Start

**Project Selection**

MainWeb – This will get you to your old Open Text site.

The other Projects listed are the sites that you have rights to make edits to.

---

RedDot Administration Home

[Home Page](#) ← This will get you to the home page you have rights to. The Webmaster can change the default.

Extra Pages *(Pages not linked to by any other page)*

[Add Links]
Spotting the Dot

Each of the areas that are circled above will have their own name and page ID associated with them.

In Open Text, the symbols below help guide you to the content you can edit.

- **Open**: Clicking on this dot will allow you to open a content area for editing.
- **Close**: Clicking on this dot will close a content area and save it to draft.
- **Standard**: This dot is used for most content elements to edit.
- **List or Container**: This dot allows addition of lists of hyperlinks or content containers. Top Content, Tab Controller and Custom Breadcrumbs are examples on content containers.
- **Locked**: Content with this dot is locked by another user.
**Page ID, Headline and Filename**

Each page is given a unique Page ID number when it is created. You are also prompted to give the page a name, which is the Headline. Page Headlines show up on the link bar. Filenames are the URL name of the page.

To find the Page ID of a page, open the page with the dot at the top of the page, the following menu will appear:

Headlines usually show up on the link list, or breadcrumb.

File name shows up in the URL of the page. The file name is used by search engines. File names should not have spaces in the name. If they do, they show up as %20 in the URL.

By default the file name is left blank. Do not leave it blank, the url for the page will show the page ID number at the end if you do so.

Change the file name to something that describes the page. If the file name needs to be more than one word, use hyphens to separate the words. Do not use underscores between words and do not merge the words together as one word.

Your main page should have the file name set to default.asp. This is done so that people can type in the name of the site without having to also type in the name of the first page. i.e., www.winona.edu/admissions would take me straight to the Admissions site. All other pages should change the file name to describe the page.
**Search to Locate the Web Content to Edit**

You may use the search feature to find pages by Content, Headline, Page ID, and Author (Created by). There are several other search options as well.

- Click on the **Search button** on the Left Menu Bar.

The screen below will appear.

**Content** – Use this field to search for a word contained on the web page

**Headline** – Use this field to search for a word contained in the left vertical navigation menu

**Drop Down Menu** – Search by Page ID, Created by and many other search criteria. Next click the green dot with the plus symbol to display a field for the text you want to type.

- **Search by Page ID:**
  - Click
  - Type the page ID number in the value field
  - Click **Start**

- **All Home Pages** are set to Page ID 8 for each project (website).
- You can use the Page ID # to search for any part in the page.
• **Search Results**

Find the page you want and click the Headline. Then Start in the lower right corner.

SmartEdit goes to the start page. This is useful to use to quickly get back to your Home Page.

Main Menu goes to Project selection

If you get to this page, select Web Content Manager to get back to the start page. There you will be able to select Home Page.
Editing Web Pages in Open Text

When you search to a page on your site, the page will either be in a Closed or Open State. The Closed State means that it is not opened by anyone else and is available to be edited.

If you see the Red Dot-Arrow Down, the page is closed

- **Preview Page** – Opens the page in a browser window
- **Edit Page** – Opens the page for editing, now no one else can open the page

The open state has five options:

- **Save Main Page** – Closes the page
- **Edit Meta Keywords** – Edits the meta keywords used by search engines
- **Edit Meta Description** – Describe what is on the page or purpose of the page
- **Add/Remove Top Content** – Used when creating a new page only
- **Add/Remove Tab Controller** – For use by Administrators only -- Do not use
Edit Interior Page Content

This page is not opened, but content area can still be edited.
Select Edit dot to edit content area.

Build Content with Manage Topics Area

If you already have a header for the page:

- Go to the dots in the content area
- Select dot next to the Header to change name. The default is Topic for the header.
- Select dot under the Header to open the editor to change content. Select OK to save and close.

Note: You should not cut and copy text from a Word document or from the web. When you do this, it brings along background code for formatting. If you want to copy text from another source, paste the information into a Notepad document first and save it. Then copy that text and paste it into the Ephox Editor. This will paste in nice clean text. You will probably need to do some formatting over again, but the text will be there.
Quick Links Area

The Quick Links area is located on the right side of the page. This is where you will put links that are pertinent to just this page. These links will not show up on every page in the site like the List of Links in the left nav bar.

- Add a picture to the top of the Quick Links area
  - Select [Edit Right Photo]
  - Right photo size:
    - 290 width x any depth
  - See section on adding photos
- Add a Photo Alt Tag
- Manage List of QuickLinks
  - Select Create and Connect
    - Select QuickLinks
    - Enter the Headline – (This will be the name of the QuickLinks area and there will be a Page ID associated with the area.)
- To Enter Links in the QuickLinks Area
  - Select [Manage Links]
  - Choose Connect Existing Page to connect to pages within your Project
    - Use Page Search menu
    - The Headline of the page will be the link name
  - Choose URL to link to a page outside your Project
    - Target drop down:
      _blank (new window)
      _parent (parent frame)
      _self (same frame)
      _top (top frame)
Choose **Create and Connect Page**
To create a new page (not covered here).

- Close the QuickLink dot with the Up Arrow

  Note: Dots are above the item

**How to make a QuickLink to a JumpMark on a different page.**
Using the Text Editor Window to Edit Content – Ephox Editor

Use standard word processing features to change, insert or delete content.

1. Click the diskette icon to **Save and Close** the window.
2. File menu > **Save** option to save and continue working in the text editor window.
3. File menu > **Save and Close** option to save your work and close the text editor window.

To exit without saving: Choose File > **Close** or click the button in the upper right corner of the window.

**NOTE:** Saving your document does NOT publish it to the web.
Edit Photo Selections

Depending on where the [Edit Photo] selection is, the size of the photo will be different. The width dimension needs to be exactly what the template requires. If it is not, the photo will not be able to be inserted, and will error out.

Edit Photo Dimensions

When you plan to insert a photo to your website, you first need to upload the image to the webserver. Before you do this, there are 3 things that need to be done to the image:
1. Change the dimension to match the area that the photo will be inserted into
2. Change the file size of the photo to be under 100K
3. Change the file name of the photo. Add one of the prefixes listed below.

<table>
<thead>
<tr>
<th>Photo Dots</th>
<th>Dimensions</th>
<th>Naming Scheme</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Edit Breadcrumb Background Photo]</td>
<td>759 x 23</td>
<td>BC-picname</td>
</tr>
<tr>
<td>[Edit Photo]</td>
<td>759 x 325</td>
<td>Large-picname</td>
</tr>
<tr>
<td>[Add Photo 519px wide]</td>
<td>519 x any</td>
<td>Med-picname</td>
</tr>
<tr>
<td>[Edit Right Photo]</td>
<td>240 x any</td>
<td>Small-picname</td>
</tr>
</tbody>
</table>

Photo Naming

Use the prefix BC, Large, Med or Small in front of your picture names so that it will be easy to find the sizes by doing an *search in your images folder.

Do not use underscores in file names, it is better to use dashes, i.e., small-front-desk.jpg
Select the Edit Photo dot. This will open the bucket of photos in the Images folder for this Project. If you have not uploaded the picture, choose Select asset from local file system at the top of the page.

Browse to your local file system for the photo.

Fill in brief Description of the photo. Can be the same text for each field.
**Uploading Images and Files**

**This process is for adding photos inside the content area only.**

If you want to add a picture in the content area that is not a designated area with the template, it is probably best to insert your image in a cell of a table.

- Put your cursor in the cell and select Insert Image from the menu bar.
- Click the Upload Image Tab if your photo has not been saved to the webserver yet.
- Next click the Upload Image button
- Click the Browse button to locate the image on your hard drive.

After selecting the image click the OK button

Next select the Images Folder from the list. These folders are only the folders for this particular Project. (Note: Projects are what you are given rights to, and choose your Project when you first get into Open Text).

Click OK
Fill in a short description of the photo. Used for search engine optimization. Can use the same name for each. This menu will show up when inserting photos with the [Edit Photo] dot.

Again fill in a short description on Alt Text field.

Note: Image Alignment does not work with our templates. Use a table to insert pictures within the content area.
Use the Images folder

If you try to upload the same picture or another picture with the same name, you will receive a message like this:
Uploading and Linking to PDF Files – Prepare before uploading

- PDF documents are preferred so that both Mac and PC’s can read them

- Two step process
  - Select File from Local File System to get file from your hard drive or network space
    - Save to the server in the Media folder
  - Select file from server
    - Insert the image
Creating Links in Open Text

Linking to a URL – (Internet Tab)

Example: Find out more information by visiting our web site: Winona State Home Page

Use this tab if you want to link to pages that are not in your Project.

Here’s How:

Highlight the text that will be the link
Click the Insert Hyperlink button on the toolbar
Choose the Internet Tab Type (or copy-paste) the URL in the field (example: www.winona.edu)
Type a brief description (example: WSU Home)
Click the Insert button

Linking to an existing WSU Open Text Page – (Page Tab)

Example: View a listing of our Biology Faculty. Use the Page Tab to link to pages within your Project.

Here’s How:

Highlight the text that will be the link
Click the Insert Hyperlink button on the toolbar
Choose the Page Tab
Search for the Open Text page ID or locate the page by using other search criteria.
Click on the name of the page
Click the Insert button

Linking to an Email Address – (Email Address Tab)

Example: For more information please email Peggy Welshons or TLT@winona.edu.

Here’s How:

Highlight the text that will be the link
Click the Insert Hyperlink button on the toolbar
Choose the Email Address Tab
Type in the email address (example: PWelshons@winona.edu)
You MUST type a description (example: Peggy Welshons)
Click the Insert button
**Linking to a File – (File Tab)**

Example: Click HERE to download the current 2007-2008 catalog. Usually you are linking to a PDF document with the File Tab. It is best to convert your documents to PDF’s so that all users will be able to view them.

**Here’s How:**

Highlight the text that will be the link  
Click the Insert Hyperlink button on the toolbar  
Choose the File Tab  
You will be prompted to select a file that has been previously uploaded to or to upload one from your computer (Local File System).

**Linking to Book Mark – (Jump Mark Tab)**

Example:  Back to Top

**Step 1:**
Insert the BookMark  
Place the cursor at the beginning of the line where you first want to create a Book Mark location.  
From the Insert Menu Click BookMark  
Type the Bookmark Name  
Click OK

**Step 2:**
Highlight the text that will be the link to the Book Mark  
Click the Insert Hyperlink button on the toolbar  
Choose the Jump Mark Tab  
Click the Select Jump Mark button  
Choose the name of the Jump Mark that you want to go to from the list.
**Creating a Table**

Open a web page in the Text Editor window and place your cursor where you want your table to be inserted.

From the **Table** pull down menu > **Insert Table....**

Rows = 3          Columns = 2

Check **Specify width** and define table in pixels = 610

At this time we will leave **Border size = 1**

Click **OK**

A table grid similar to the one below will appear:

<p>| | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Merge the top two cells in row one:

First highlight the cells then merge by one of the following methods

- Click the Merge button
- From the Table menu click Merge Cells
- Right Click on the highlighted cells and select Merge Cells

<p>| | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

In the top cell, type the text “Learning Opportunities”

Increase the font size, center the text and change the font color to purple.

<table>
<thead>
<tr>
<th>Learning Opportunities</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
</tr>
</tbody>
</table>

Merge the next row of cells together and add a background color of gray.

Be sure your cursor is in the row you just merged

Table menu > **Cell properties**
Select a light gray for the background color

<table>
<thead>
<tr>
<th>Learning Opportunities</th>
</tr>
</thead>
<tbody>
<tr>
<td>A New Look at Classroom Discussion</td>
</tr>
<tr>
<td>Introducing simple Online Forms and Surveys</td>
</tr>
</tbody>
</table>

**Remove Cell Padding, Cell Spacing and Remove Gridlines**

Put the cursor anywhere in the table

Table menu > Table Properties

- Border = 0
- Cell Spacing = 0
- Cell Padding = 0

Put the cursor in cell to change alignment (Vertical and Horizontal)

Table menu > Cell properties
Releasing and Publishing Your Web Page

Publishing your web page may vary depending how your Open Text access has been setup. Here are some basic guidelines:

Save your page (in the HTML editor, use the File Save option)

Go to the Action tab in the Page

Select these from the Actions menu. You will need to go back into the Action tab for each one. You also may not need to do the first two. You know your page is ready to publish if it is at the top of choices.

- Submit to workflow
- Release the Page
- Publish

Select OK